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Safety Notices
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WARNING notice until the 
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Where to Find the Latest Information

Documentation is updated periodically. For the latest information about these products, including instrument 
software upgrades, application information, and product information, browse to one of the following URLs, 
according to the name of your product:

https://www.keysight.com/us/en/support/AP5041A/ap5041a-g3-vector-signal-generator-up-to-40-ghz.h
tml

https://www.keysight.com/us/en/support/AP5042A/ap5042a-g3-vector-signal-generator-up-to-40-ghz.h
tml

To receive the latest updates by email, subscribe to Keysight Email Updates at the following URL:

https://support.keysight.com

Information on preventing instrument damage can be found at:

http://www.keysight.com/find/PreventingInstrumentDamage

Is your product software up-to-date?

Periodically, Keysight releases software updates to fix known defects and incorporate product enhancements. 
To search for software updates for your product, go to the Keysight Technical Support website at:

http://www.keysight.com/find/techsupport
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Product and Solution Cybersecurity

Keysight complies with multinational regulations for the cybersecurity of its own products and is committed 
to providing information to assist you in protecting your products and solutions from external cyber threats. 
For more information, see:

https://www.keysight.com/us/en/about/quality-and-security/security/product-and-solution-cyber-security.html

Keysight also recommends that you secure your IT environments using appropriate third-party tools. For 
instruments that run the Microsoft Windows operating system, Keysight concurs with Microsoft's 
recommendations for ensuring that the instrument is protected:

- Get the latest critical Windows updates

- For network-connected instruments, use an Internet firewall (in Keysight instruments, Windows Firewall 
is enabled by default)

- For network-connected instruments, use up-to-date antivirus and anti-spyware software

Responsible Disclosure Program

Keysight recommends that security researchers share the details of any suspected vulnerabilities across 
any asset owned, controlled, or operated by Keysight (or that would reasonably impact the security of 
Keysight and our users) using this form:

https://www.keysight.com/us/en/contact/responsible-disclosure-program.html

Report a Product Cybersecurity Issue

If you discover a cybersecurity issue that you suspect may involve Keysight's proprietary software, or 
third-party software supplied by Keysight as part of a product, or that may affect the operation of Keysight 
products, we encourage you to report it to us using this form:

https://www.keysight.com/us/en/about/quality-and-security/security/product-and-solution-cyber-security/report-
a-product-cybersecurity-issue
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Keysight AP5041A/AP5042A Vector Signal Generator

User’s Manual

1 Quick Start

The following topics can be found in this section:

“Introduction” on page 10

“Models Covered in this Manual” on page 10

— “AP5041A G3 Desktop Front and Rear Panel Connectors” on page 11

— “AP5042A G3 2U Front and Rear Panel Connectors” on page 12

“Minimum Distances” on page 14

“Energizing and de-Energizing” on page 17

“Data Connections” on page 18

“Signal Connections” on page 18

“Transportation” on page 19

“Safety Information” on page 20

“Getting Started” on page 24
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Introduction

Introduction
Today, digital modulation schemes are widely used in communication systems, 
and the increasing need for data bandwidth has pushed the signal purity and 
modulation bandwidth requirements for modern vector signal sources. Other 
applications with similar performance requirements include radio surveillance, 
interference analysis, radar signal analysis, and electronic warfare.

Addressing these demanding requirements, Keysight’s AP5041A and AP5042A 
vector signal generators (VSGs) provide frequency coverage to 40 GHz and are 
available as single output desktop units or rack-mount instruments with 
multiple phase-coherent outputs. They offers a cost-effective and flexible tool 
for generating high-quality, complex, wideband, digitally modulated signals.

Among others, the following use cases are supported: 

— Upload multiple formats of IQ Data into instrument memory. The AP5041A 
and AP5042A internal AWG can play selected sections of the RAM upon a 
user trigger.

— Use the AP5041A and AP5042A to synthesize and play predefined digital 
modulation formats.

— Use the fast control port (FCP) interface to live stream and play digital IQ 
data.

— Use FCP to control the AP5041A and AP5042A for ultra fast frequency 
hopping.

The AP5041A and AP5042A operate with an ultra stable temperature 
compensated frequency reference (OCXO) that can be phase locked to an 
external reference.

The compact unit allows for full front panel control via touch a touch panel 
display, and PC GUI software supported operation via Ethernet, USB, FCP and 
GPIB communication ports.

Models Covered in this Manual

— AP5041A G3 Desktop

— AP5042A G3 2U Rack Mount Enclosure
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AP5041A G3 Desktop Front and Rear Panel Connectors

Figure 1-1 AP5041A front panel (with touch display)

1. Touch Display - shows information on the current function, such as 
frequency, power, and reference.

2. Rotary Button - used to change the value selected on the display.

3. RF 50 - provides the output for generated signals. The impedance is 
50 . Please refer to the data sheet for more details.

Figure 1-2 AP5041A rear panel

1. REF Input - input for the reference signal (BNC female connector).

2. REF Output - output for the reference signal (BNC female connector).

3. I Input- input for analog in-phase signals (BNC female connector).

4. Q Input- input for analog quadrature signals (BNC female connector).

5. MF1 Input - multifunction input(BNC female connector).

6. MF1 Output - multifunction output(BNC female connector).
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7. MF2 Input - multifunction input(BNC female connector).

8. MF2 Output - multifunction output(BNC female connector).

9. USB-B - used to connect the device to a computer.

10. LAN - used to connect the device to the network.

11. AC Power - Connector for AC power

12. Ground Screw - used to connect the device to ground reference.

13. GPIB - for Option GPIB.

14. RF OUT - provides the output for generated signals. The impedance is 
50 . Please refer to the data sheet for more details. 

15. CLK IN - proprietary port for multi-instrument synchronization.

16. CLK OUT - proprietary port for multi-instrument synchronization.

17. SYNC connectors. SYNC OUT ports from the primary instrument are 
connected to the SYBNC IN port to the follower unit.

— "A" Time stamp reference signal

— "B" Communication, forward channel

— "C" Communication, return channel (for future use)

18. SD Card

AP5042A G3 2U Front and Rear Panel Connectors

Figure 1-3 AP5042A front panel 

1. Power LED - indicates whether the instrument is on our off. 

2. Ready LED - indicates that the boot process is completed and the 
instrument is ready to use.

3. Remote LED - when on, indicates the instrument is connected to a 
computer.

4. RF LED (1 through 4) - indicates whether the RF signal is on or off.

5. RF OUT (1 through 4) - provides the output for generated signals. The 
impedance is 50 . Please refer to the data sheet for more details. 
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Figure 1-4 AP5042A rear panel

1. FCP - Fast control port, see Application note AN6002.

2. MF1 Input - multifunction input(BNC female connector).

3. MF1 Output - multifunction output(BNC female connector).

4. CLK IN - proprietary port for multi-instrument synchronization.

5. CLK OUT - proprietary port for multi-instrument synchronization.

6. REF IN - output for the reference signal (BNC female connector).

7. REF OUT - input for the reference signal (BNC female connector).

8. GPIB - for Option GPIB.

9. LAN - connects the instrument to a network.

10. USB -B - connects the instrument to a computer.

11. Fuse Holder - Provides an exchangeable fuse.

12. AC Power - Connector for AC power

13. ON/Off Switch - Turns the instrument on or off.

14. Ground Screw - Used to connect the device to a ground reference.
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Minimum Distances

Safety of any system incorporating the equipment is the responsibility of 
the assembler of the system.

For an adequate cooling, the minimum distances between the device and 
another object, such as walls, rack cabinet walls or other equipment must 
be respected.
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2U

— A: 1 mm

— B: 1 mm

— C: 50 mm

— D: 50 mm

Figure 1-5 Minimum distance for the 2U 
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Desktop

— A: 0 mm

— B: 0 mm

— C: 50 mm

— D: 50 mm

— E: 150 mm

— F: 150 mm

Figure 1-6 Minimum distance for the Desktop
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Energizing and de-Energizing
To energize the device, apply the following voltage to the following connector.

Position of the power connector on the right. 

Use Keysight supplied power cord or one with same or better electrical 
rating.

The Mains wiring, and connectors shall be compatible with the connector 
used in the premise electrical system. Failure to ensure adequate earth 
grounding by not using the correct components may cause product 
damage, and serious injury.

Always use the three-prong AC power cord supplied with this product. 
Failure to ensure adequate earth grounding by not using this cord can 
cause product damage.

Before switching on this instrument, make sure the supply voltage is in the 
specified range.

Only use the power adapter supplied with the equipment. The use of other 
devices is not permitted.

Install the instrument so that the detachable power cord is readily 
identifiable and is easily reached by the operator. The detachable power 
cord is the instrument disconnecting device. It disconnects the mains 
circuits from the mains supply before other parts of the instrument. 

The main power cord is the system disconnecting device. It disconnects 
the mains circuits from the mains supply.

The instrument can operate with mains supply voltage fluctuations up to ± 
10% of the nominal voltage.



18                                                                        Keysight AP5041A/AP5042A User’s Manual

Quick Start
Data Connections

Figure 1-7 AP5041A

Figure 1-8 AP5042A 

The 2U rack mount case has a fuse that is accessible from the outside. To 
change the fuse, pull out the mains plug, open the fuse holder in the middle of 
the power entry module on the back panel. Replace the old fuse with a new 
one. It is forbidden to repair defect fuses or to bridge them by any means. Use 
only a fuse with the rating specified on the instrument's fuse rating plate.

Data Connections
The devices may only be connected to a network or a computer by using a 
shielded LAN cable. Unless shorter lengths are prescribed, a maximum length 
of 3 m must not be exceeded for the LAN and the USB connection. 

Signal Connections
In general, all connections between the signal generator and another device 
should be made as short as possible and must be well shielded. It is 
recommended to use a high-quality cable with low loss especially for 
frequencies above 20 GHz.
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Transportation

Transportation
The devices must only be transported with the packaging supplied by the 
manufacturer. The device can be lifted or transported in any orientation.



20                                                                        Keysight AP5041A/AP5042A User’s Manual

Quick Start
Safety Information

Safety Information
The following pieces of information are important to prevent personal injury, 
loss of life or damage to the equipment. Please read them carefully. If the 
device is used in a manner not specified by this manual, the protection 
provided by the device may be impaired.

Safety Symbols

In this manual, the following symbols are used to warn the reader about risks 
and dangers.

Instrument Markings

The table below lists the definitions of markings that may be on or with the 
product. Familiarize yourself with each marking and its meaning before 
operating the signal generator.

A WARNING notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed or adhered 
to, could result in personal injury or death. Do not proceed beyond a 
WARNING notice until the indicated conditions are fully understood and 
met.

A CAUTION notice denotes a hazard. It calls attention to an operating 
procedure, practice, or the like that, if not correctly performed or adhered 
to, could result in damage to the product or loss of important data. Do not 
proceed beyond a CAUTION notice until the indicated conditions are fully 
understood and met. 

This product has been designed and tested in accordance with accepted 
industry standards and has been supplied in a safe condition. The 
documentation contains information and warnings that must be followed 
by the user to ensure safe operation and to maintain the product in a safe 
condition.

Marking Description

This symbol marks the standby position of the power line switch.

This symbol marks the ON position of the power line switch.

This symbol marks the OFF position of the power line switch.
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This symbol indicates that the input power required is AC.

This symbol indicates DC voltage

This symbol indicates a three-phase alternating current.

This symbol indicates Frame or chassis Terminal.

The instruction documentation symbol. The product is marked with this symbol 
when it is necessary for the user to refer to the instruction in the documentation.

This symbol indicate the presence of a laser device.

This symbol indicates the surface can be hot.

This symbol indicated the product is sensitive to electrostatic discharge.

This symbol identifies the Protective Conductor terminal.

This symbol indicates the equipment is protected throughout by double or 
reinforced insulation.

The CE mark is a registered trademark of the European Community (if accompanied 
by a year, it is the year when the design was proven). It indicates that the product 
complies with all the relevant directives.

The UK conformity mark is a UK government owned mark. Products showing this 
mark comply with all applicable UK regulations.

The Keysight email address is required by EU directives applicable to our product.

The CSA mark is a registered trademark of the CSA International.

Marking Description
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Canada EMC label.

Interference-Causing Equipment Standard for industrial, scientific and medical 
(ISM) equipment. Matériel industriel, scientifique et médical (ISM).

CE/ICES/ISM label. (Old mark for reference only.)

This is a space saver label that combines three markings - CE with CAN ICES and 
ISM (see above) and ISM (see below).

This is a space saver label that combines three markings - CE with CAN ICES and 
ISM (see above) and ISM (see below).

The RCM mark is a registered trademark of the Australian Communications and 
Media Authority.

This is a space saver label that combines two markings - CAN ICES and ISM.

This is a symbol of an Industrial Scientific and Medical Group 1 Class A product 
(CISPR 11, Clause 5).

South Korean Certification (KC) mark. It includes the marking’s identifier code.

The crossed-out wheeled bin symbol indicates that separate collection for 
waste electric and electronic equipment (WEEE) is required, as obligated by the 
EU DIRECTIVE and other National legislation. Please refer to 
www.keysight.com/go/takeback to understand your trade-in options with 
Keysight, in addition to product takeback instructions.

China Restricted Substance Product Label. The EPUP (environmental protection use 
period) number in the center indicates the time period during which no hazardous or 
toxic substances or elements are expected to leak or deteriorate during normal use 
and generally reflects the expected useful life of the product.

Universal recycling symbol. This symbol indicates compliance with the China 
standard GB 18455-2001 as required by the China RoHS regulations for 
paper/fiberboard packaging.

This mark indicates product has been designed to meet the requirements of "IP x y", 
where "x" is the solid particle protection and "y" is the liquid ingress protection.

Marking Description
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General Safety Considerations

FCC Notice

This equipment has been tested and found to comply with the limits for a Class 
A device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instruction manual, may cause harmful 
interference to radio communications.

Operation of this equipment in a residential area may cause harmful 
interference in which case the user will be required to correct the interference 
at his or her expense.

If products or their components are mechanically and/or thermally 
processed in a manner that goes beyond their intended use, hazardous 
substances (heavy-metal dust such as nickel) may be released. For this 
reason, the product may only be disassembled or opened by specially 
trained personnel. Improper disassembly may be hazardous to your health. 
National waste disposal regulations must be observed.
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Getting Started

Included Material

Your signal generator kit contains the following items:

— Signal Generator

— Country specific plugs

— Ethernet Cable

Power Requirements

System Requirements

The Keysight graphical user interface requires at least the minimum system 
requirements to run one of the supported operating systems.

Operating system

Windows 7, 8, 10, 11

Remote connection

10/100/1000M Ethernet or USB 2.0 Port

Initial Inspection

Inspect the shipping container for damage. If container is damaged, retain it 
until contents of the shipment have been verified against the packing list and 
instruments have been inspected for mechanical and electrical operation.

Input Voltage, Frequency, and Current 100-240 V 50-60 Hz, 2 A

This is a Safety Protection Class I Product (provided with a protective 
earthing ground incorporated in the power cord). The mains plug shall only 
be inserted in a socket outlet provided with a protective earth contact. Any 
interruption of the protective conductor inside or outside of the product is 
likely to make the product dangerous. Intentional interruption is 
prohibited.

If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.

The instrument’s power adapter is auto-ranging. Be sure the supply 
voltage is within +/-10% of the specified rating.
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Unpacking the Instrument

Remove the instrument materials from the shipping containers. Save the 
containers for future use.

For a list of material included in the standard package, please refer the 
“Included Material” section.

Starting the Instrument

This section describes installation instructions and verification tests.

Applying Power

Place the instrument on the intended workbench and plug into power.

For the AP5041A only, press the power button and the instrument will initialize 
and momentarily display the model number, firmware revision and product 
serial number. The display will then switch to the factory default display 
setting, showing preset frequency (100 MHz) and power, phase lock status (of 
internal reference) and instrument connectivity status (Ethernet IP or USB 
identifier).

For the AP5042A only, press the line on/off switch. on the rear panel and the 
front panel display will illuminate. 

Connecting the Instrument

Connecting to LAN

Connect the instrument to your local area network (LAN) using the Ethernet 
cable. By default, the instrument is configured to accept its dynamic IP number 
from the DHCP server of your network. If it is configured properly, your network 
router will assign a dynamic IP number to the instrument. Your instrument is 
now ready to receive remote commands.

Direct Connectivity to Host Via Ethernet Cable (no router)

You can connect the instrument to your computer with the Ethernet cable 
without using a local area network with DHCP server. To work properly, the 
network controller (NIC) of your computer must be set to an IP address 
following the ZEROCONF standard, beginning with 169.254.xxx.xxx (excluding 
169.254.1.0 and 169.254.254.255) and network mask 255.255.0.0 to match 
the ZEROCONF IP that the signal generator will assign itself after DHCP 

Using supplies other than those provided by Keysight may lead to 
malfunction and damage of the Instrument.

The instrument booting process may take up to 60 seconds (depending on 
configuration) to complete.
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timeout. Any fixed address in the above-mentioned range is admissible as well. 
The generators ZEROCONF address cannot be predicted as it is assigned 
dynamically, however the ZEROCONF address assignment process ensures it 
will not conflict with any other address used in the network. 

Connection from a NIC that is configured to use DHCP is also possible. After a 
pre-set timeout, the NIC will assume that no DHCP is available and self-assign 
a default IP that will fall into the range 169.254.xxx.xxx.

Alternatively, you may assign the instrument a fixed IP. Please refer to a later 
section of this manual to learn how to do this.

Connecting through USB

Connect the (powered on) instrument to the computer using a quality USB 
type-A to type-B cable. If properly connected, the computer host should 
automatically recognize your instrument as a USBTMC device.

Alternatively, a VISA runtime environment (NI, Keysight or comparable) must 
be installed.

Use VISA Write to send the *IDN? Query and use VISA Read to get the 
response. The USBTMC protocol supports service request and triggers.

Connecting through GPIB

Connect the instrument to the GPIB controller using the rear panel GPIB 
connector (option GPIB is required). Once connected properly, use VISA Write 
to send the *IDN? query and use VISA Read to get the response. The protocol 
supports service request, triggers and other GPIB specific operations.

Installing the Signal Generator’s Remote Client

Keysight’s graphical user interface provides an intuitive control of the 
instruments. It runs under the Windows operating system with minimum 
requirements. The DLL is embedded in the GUI application and requires the 
Microsoft .NET™ framework to be installed. To install the GUI on the computer, 
download it from Keysight.com.

The self-extracting setup provides easy installation and uninstallation of the 
software. The setup program guides you in a few steps though the installation 
process. In case the NET framework is not installed on your current Windows 
operating system, the setup procedure will assist you automatically to install 
the required version. For this you will need an active Internet connection.

If you want to work with the Keysight GUI, it must be installed with USB support selected. Then 
the GUI will detect all attached devices automatically. Open the GUI and follow the instructions 
given in “Using the Graphical User Interface (GUI)” on page 61.
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Troubleshooting the LAN Interconnection

Software does not install properly

— Make sure the Microsoft .NET Framework was properly installed during the 
UI installation process.

Software cannot detect any instrument

— Make sure you have connected both computer and instrument to a 
common network.

— If a direct connection is used you may need to reset your computer Ethernet 
controller (depending on the configuration). Note that in this case detection 
of the instrument can take a considerable amount of time if your computer 
is configured to work with an external DHCP server. In some cases, the 
detection may even fail completely. Configure your computer network 
controller to an appropriate fixed IP instead.

— Make sure that your software firewall enables the GUI to setup a TCP/IP 
connection via the LAN. Under Windows 7/10, open the Control Panel 
under Settings in your Start menu. Then go to Windows Firewall. Select 
Exceptions and then add Program. If the GUI is in this list, choose it and 
select OK otherwise browse for the path to GUI installation directory. Finally 
close all open dialogs by selecting OK. Now your Windows Firewall will not 
block requests from the GUI.

Shutting Down the Signal Generator

Press the on/off switch on the rear panel to turn off.
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2 Front Panel Operation (Applies to the AP5041A only)

The following topics can be found in this chapter:

“RF 50 Ω Connector” on page 31

“Rotary Button” on page 31

“Front Panel Settings” on page 31

“RF > CW Menu” on page 31

“RF > Sweep Menu” on page 32

“Modulation Submenus” on page 36

“Reference Submenu” on page 53

“RF > Sweep > Trigger Submenu” on page 35

“RF > Sweep Trigger > Out Submenu” on page 35

“Configuration” on page 56

“Configuration > Preset Submenu” on page 56
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The front panel display allows you to access many of the AP5041A functions. 
However, the GUI interface allows you access all available functions.

Figure 2-1 Front panel with touch display
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RF 50 Ω Connector
Depending on your model number, the female Type N connector or the male 
2.92 mm connector provides the output for RF signals. The impedance is 50 Ω. 
The damage levels for RF and DC are specified in the data sheet.

Refer to the data sheet for more information.

Rotary Button
The rotary button is used to switch between cursor positions and to 
continuously change values at the cursor position. 

The currently active display position is shown by the cursor (underline symbol, 
or different background color). The cursor does not move beyond the field of 
the currently selected parameter. Rotate the front panel knob to modify the 
value. Clockwise rotation increases the parameter and counter-clockwise 
rotation decreases the parameter. The parameter value will continue to 
increase or decrease by the amount of the selected resolution until it reaches 
the maximum or minimum limit of the parameter. 

Front Panel Settings
The following sections describe how to control the instrument via the front 
panel.

RF > CW Menu

The Main display or CW Menu is shown after the instrument has successfully 
booted and is ready. The menu keys are displayed at the bottom of the screen. 
You can set the CW frequency, power level and phase from the CW menu. 

P1 and P2 work as a toggle switch. Therefore, if you are currently viewing 
P2 and want to go to P1 then press P2 again.
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Figure 2-2 Panel 2 Display

Figure 2-3 Panel 1 Display 

RF > Sweep Menu

The Sweep menu on the instrument front panel has three submenus. The 
Configuration submenu provides additional settings for the Frequency and 
Power submenus.

— Frequency

— Power

— Configuration

The Configuration submenu provides additional settings for the Frequency 
and Power submenus.

— Trigger
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RF > Sweep > Frequency Submenu)

The front panel Sweep > Frequency submenu, allows you to specify the 
start/stop frequency and the step size. The Sweep > Conf submenu allows you 
to set the number of points, dwell time, and off time repetition mode between 
INFinite, and 1 (single repetition). The sweep is started by pressing the RF 
On/Off button. 

Figure 2-4 Frequency Display

RF > Sweep >Power Submenu

The front panel Sweep >Power submenu, allows you to specify the start/stop 
power and the step size. The Sweep > Conf submenu allows you to set the 
number of points, dwell time, and off time repetition mode between INFinite, 
and 1 (single repetition). The sweep is started by pressing the RF On/Off 
button.

The remote GUI allows you to set the same settings above plus, Sweep Mode, 
RF blank until trigger, and ALC Mode.
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Figure 2-5 Power Display

RF > Sweep > Configuration Submenu

Figure 2-6 Panel 1 Configuration Display 
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Figure 2-7 Panel 2 Configuration Display 

RF > Sweep > Trigger Submenu

— Out

— Source

— Configure

RF > Sweep Trigger > Out Submenu

The Trigger Out submenu accesses the trigger output delay, pulse width, 
polarity, and output mode.

Figure 2-8 Out Display 
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RF > Sweep Trigger > Source Submenu

The Trigger Source is used to set the source to Immediate, Bus, or External. 
Additional settings for the External source can be specified for MF 1 or MF2 
and triggered on the positive or negative edge.

Figure 2-9 Source Display 

RF > Sweep >Trigger > Configure Submenu

The Configure submenu is used set the trigger mode, type and delay.

Figure 2-10 Configure Display

Modulation Submenus

The modulation section gives access to most settings related to available 
modulations. The different types of modulations are grouped in submenus, 
which include but may not be limited to:
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— Arbitrary modulation

— Waveform modulation

— Waveforms on SD memory (AP5041A Option 006)

— Fast control port, external digital I/Q data streaming (AP5041A 
Option FCP)

— Analog modulations (AP5041A Option UNT for AM, FM, and phase 
modulation. AP5041A Option PMR for limited Pulse modulation or AP5041A 
PME for Pulse modulation.)

Including AM, FM, PM, and Pulse modulation settings

— Differential external analog IQ inputs (AP5041A Option EXT)

— Additive white Gaussian noise modulation (AP5042A Option 403)

— AVIO modulations (AP5041A Option 302)

Including settings for VOR, ILS, and DME

— Digital modulations (AP5041A Option 431)

Modulation > ARB Submenu

Sets the parameters for an arbitrary modulation.

— WAVE

— SD

— FCP

Modulation > ARB > WAVE Submenu

Figure 2-11  WAVE Display
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Modulation > ARB > SD Submenu

Figure 2-12 Secure Digital (SD) Card Display

Modulation > ARB > AIQ Submenu

Figure 2-13 AIQ (Analog In-phase and Quadrature) Display
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Modulation > ARB > FCP Submenu

Figure 2-14 FCP (Fast Control Port) Display

Modulation > ANLG Submenu

The Analog Modulation Submenu allows you to access the parameters for 
Pulse, AM, FM and PM modulation.

Modulation Analog > Pulse Modulation Submenu

In the pulse modulation submenu the pulse width, pulse period and pulse 
trigger can be configured in the following tabs:

— Main

Main and Out work as a toggle switch. Therefore, if you are currently 
viewing Out and want to go to Main then press Out again.
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Figure 2-15 Main Display

— OUT

Figure 2-16 OUT Display

Modulation > ANLG > AM (Amplitude Modulation) Submenu

In the amplitude modulation submenu the internal amplitude modulation can 
be accessed.
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Figure 2-17 AM Display

Modulation > ANLG > FM (Frequency Modulation) Submenu

In the frequency modulation submenu the internal and external frequency 
modulation can be accessed. It is possible to change between internal and 
external modulation source and to change modulation parameters such as 
modulation rate, depth or sensitivity.

Figure 2-18 FM Display

Modulation > ANLG > PM (Phase Modulation) Submenu

In the phase modulation submenu the internal and external phase modulation 
can be accessed. It is possible to change between internal and external 
modulation source and change modulation parameters.
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Figure 2-19 Phase Display

Modulation > AWGN Submenu

Figure 2-20 AWGN Display
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Modulation > AVIO > VOR (Very High Frequency) Submenu

Figure 2-21 AVIO VOR Main Display

Figure 2-22 AVIO VOR CONF1 Display
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Figure 2-23 AVIO VOR CONF2 Display

Figure 2-24 AVIO VOR IDENT Display
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Modulation > AVIO > ILS (Instrument Landing System) LOC (Localizer) 
Submenu 

Figure 2-25 AVIO > ILS LOC > MAIN Display

Figure 2-26 AVIO > ILS LOC > CONF1 Display
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Figure 2-27 AVIO > ILS LOC > CONF2 Display

Figure 2-28 AVIO > ILS LOC > IDENT Display
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Modulation > AVIO > ILS (Instrument Landing System) GS (Glideslope) 
Submenu 

Figure 2-29 AVIO > ILS GS > MAIN Display

Figure 2-30 AVIO > ILS GS > CONF1 Display



48                                                                      Keysight AP5041A/AP5042A User’s Manual

Front Panel Operation (Applies to the AP5041A only)
Front Panel Settings

Figure 2-31 AVIO > ILS GS > CONF2 Display

Modulation > AVIO > DME (Distance Measuring Equipment) Submenu 

Figure 2-32 AVIO > DME > MAIN Display
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Figure 2-33 AVIO > DME > SHAPE Display

Figure 2-34 AVIO > DME > CONF2 Display
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Figure 2-35 AVIO > ILS GS > IDENT Display

Modulation > AVIO > NDB (Non Direction Beacon) Submenu 

Figure 2-36 AVIO > NDB > MAIN Display
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Figure 2-37 AVIO > NDB > IDENT Display

Modulation > QAM

Figure 2-38 QAM Display
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Modulation > Trigger

Figure 2-39 Configure Display

Figure 2-40 Source Display
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Figure 2-41 Out Display

The Sweep Trigger Subsystem provides the trigger parameters for the select 
modulation. 

Reference Submenu

In the Reference menu the internal or external reference source and the 
reference output signal can be selected and configured.

Figure 2-42 Reference

Input Output (IO) Submenu

This menu includes configurations for input and output ports of the device. 
Submenus included here, are:

— Multifunction Output - Select the signal to be output at each of the 
multifunction ports.
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— Fast Control Port (Option FCP) - Configure the FCP interface to interpret 
received signals appropriately.

— Analog Input Port (Option EXT) - Configure the analog input interface and 
set gain and offset for applied input signals.

IO > MFO (Multi Function Output)

Figure 2-43 MFO > MF1 Display

Figure 2-44 MFO > MF 2 Display

MF 1 and MF 2 work as a toggle switch. Therefore, if you are currently 
viewing MF 2 and want to go to MF 1 then press MF 2 again.
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IO > AIN (Analog Input) > MF 2 Submenu

Figure 2-45 AIN > AIN1 Display

Figure 2-46 AIN > AIN2 Display

IO > FCP (Fiber Channel Protocol) Submenu

This menu is available for both MF1 and MF2. 

AIN 1 and AIN 2 work as a toggle switch. Therefore, if you are currently 
viewing AIN 2 and want to go to AIN 1 then press AIN 2 again.
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Figure 2-47 FCP Display

Configuration 

The Configuration submenu is divided into the following submenus: 

— PRESet

— COMMunication

— DISPlay

— INFO

— TEST

Configuration > Preset Submenu

In the Preset Settings submenu, specific settings can be stored to the 
instrument or loaded from the instrument. You can also restore the factory 
default settings.
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Figure 2-48 Preset Display

Configuration > Communication Submenu

In the Communication submenu, IP address, subnet mask and DHCP can be 
configured.

Figure 2-49 Communication Display

Configuration > Display Submenu

In the Display submenu, configuration of the instrument via the display can be 
disabled or enabled.
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Figure 2-50 Display 

Configuration > Info Submenu

In the Info Submenu, information about the device is shown (serial number, 
firmware version, and options installed).

Figure 2-51 Info Display

Configuration > Test Submenu

The Test Submenu allows you to perform a self test on the instrument.
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Figure 2-52 Test Display

Configuration > Tune Submenu

Figure 2-53 Tune Display

Allows you to adjust frequency tuning. 



60                                                                      Keysight AP5041A/AP5042A User’s Manual

Front Panel Operation (Applies to the AP5041A only)
Front Panel Settings



61

Keysight AP5041A/AP5042A Vector Signal Generator

User’s Manual

3 Using the Graphical User Interface (GUI)

This section describes the following features:

“Start the Signal Generator GUI” on page 62

“Simultaneously controlling Multiple Signal Generators from one PC” on 
page 63

“Setting Network Configuration” on page 63

“Device Port Setting” on page 63

“Setting the GPIB Address” on page 64

“Upgrading the Firmware” on page 64

“Remotely Programing the Signal Generator” on page 65

“Menus” on page 67

— “RF Tab” on page 67

— “IO (Input Output) Tab” on page 67

— “Carrier Section” on page 69

— “Crest Factor Section” on page 69

— “Modulation Section” on page 70
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Start the Signal Generator GUI
Keysight’s graphical user interface provides an intuitive control of the signal 
generator. It runs under any Windows operating system. Make sure the 
software is installed correctly and the computer’s firewall is configured 
properly. The GUI’s dynamic link library (DLL) uses the Microsoft .NET 
framework. The GUI offers additional functionality that is not available on the 
instrument front panel.

Get the latest version of the Vector Signal Generator GUI at:

https://www.keysight.com/us/en/support/AP5041A/ap5041a-g3-vector-sig
nal-generator-up-to-40-ghz.html#drivers

After successful installation of the software double-click the software shortcut 
that has been created on your desktop.

After start, the GUI will automatically detect existing Keysight instruments that 
are connected to the computer (network) via local area network or USB. In the 
CONTROL tab (see Figure 3-1) the detected instruments are listed. Clicking on 
one of the devices will instantly establish connection. Clicking on an alternate 
device will disconnect the old device and reconnect to the new device. Scan 
Instruments button will enable automated scanning for new instruments. 
Disconnect/Connect button will establish and terminate connection.

Figure 3-1 Vector Signal Generator GUI
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Simultaneously controlling Multiple Signal Generators from one PC

You can easily control multiple instruments from a single computer but you 
need to start a separate GUI for every instrument as only one instrument is 
controlled by a single GUI.

Setting Network Configuration

The Device > Network Configuration menu allows configuring the LAN settings. 
You may choose from three distinct network addressing modes: setting to 
AUTO will check for a DHCP server on the network but if this fails, will fall back 
to assigning an address automatically using zeroconf. Setting to DHCP will 
check for a DHCP server on the network with no fallback option if one doesn’t 
exist. Setting to MANUAL will require the user to supply all network settings for 
the device manually as shown below. Additionally, the device name can be 
modified as desired. The unit’s serial number and firmware revision are 
displayed at the bottom of the dialog box.

Figure 3-2 Network Configuration dialog box

Device Port Setting

The 'Port' option allows the listening TCP port to be customized for the device. 
The default setting for all devices is port 18. If changed, the device will no 
longer be accessible using this port number. Any instances of the UI (or other 
VISA applications connecting to the device over a network) will need to modify 
their destination port number to match the device to connect to.

Connecting to Devices Using a Non-default Port

There are two options for connecting to a device when its default listening port 
has been changed.

— Specify a temporary port
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1. From the main menu, select Device > Info > Connection Settings > 
Specify Connection Port. 

This will cause a new setting Custom Port to be displayed on the 
'Control' tab of the UI.

2. The connection port to use can then be entered (within the range of 
permissible TCP port numbers). Beware that this setting will 
overwrite the default port until it is removed. 

3. To remove, select Specify Connection Port. 

This will remove the 'Custom Port' setting from the UI and revert to 
using the current default port. Deleting the port number from the 
'Custom Port' text box will also cause the UI to revert to using the 
default port.

— Change the application's default port setting

1. The global default port used for connections can be changed by 
selecting menu 'Info' -> 'Connection Settings' -> 'Change Default 
Port' (see figure 6-d).

2. The global default port used for connections can be changed by 
selecting Device > Info > Connection Settings > Change Default 
Port.

3. Enter the default port into the dialog box and select Set Default 

Only permissible TCP ports can be entered here. If the new default 
port is accepted, the '[Default=]' text above will display the new 
setting. Beware that the new default setting will now persist until 
changed again - including after restarting the UI or rebooting your 
system.

Setting the GPIB Address

If the instrument has the GPIB option installed, the GPIB address can be 
changed in the GPIB submenu in the Control tab. Valid GPIB addresses range 
from 1 to 30.

To verify GPIB functionality, use the VISA Assistant available with the Keysight 
IO Library or the Getting Started Wizard available with the National Instrument 
IO Library. These utility programs enable you to communicate with the signal 
generator and verify its operation over GPIB. For information and instructions 
on running these programs refer to the Help menu available in each utility.

Upgrading the Firmware 

A firmware upgrade of the instrument can be done directly via the GUI.   

Do not disconnect and power off the device during a firmware upgrade.
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1. Make sure you are connected to the correct instrument and have the correct 
firmware binary file (.tar) ready.

2. Select Controller > Update Firmware.  
https://www.keysight.com/us/en/lib/software-detail/instrument-firmwar
e-software/ap504xa-firmware.html

The update will take a few seconds. After completion, your instrument will 
reboot. Reconnect to the instruments after booting is completed and 
continue with the updated firmware.

Remotely Programing the Signal Generator

The signal generator can be remotely programmed with the use of SCPI 
commands. Please refer to the Programmer's Manual for details.

https://www.keysight.com/us/en/support/AP5041A/ap5041a-g3-vector-sig
nal-generator-up-to-40-ghz.html#
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AP5041A/42A Operation via the GUI
The single channel signal generator may be operated via the graphical user 
interface (GUI) or directly from the front panel (AP5041A only). The 
multichannel models are operated via the GUI. All  models can optionally be 
remotely controlled with SCPI commands, as described in section “Remotely 
Programing the Signal Generator” on page 65. 

The following section descibes basic functions of the device are explained. 
Examples demonstrate a selection of modulated signals that can be generated 
with the APVSG. The GUI is used to control the signal generator in the 
examples.
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Menus
The GUI provides the following menus: 

— RF

— IO (Input Output)

— Carrier

— Crest Factor

— Modulation

— Generator

— Pulse Train

— Analog Modulation

— Digital Modulation

— External Modulation

— AWGN Modulation

— AVIO Modulation

— Arbitrary 

— Sweep

RF Tab

Use the RF dialog to set the parameters of the carrier and modulation signal 
and to turn RF on and off.

IO (Input Output) Tab

Use the IO dialog to configure MF outputs 1 and 2. Choices are:

 MF (Multi Functional) Configuration 

— Off - Inactivates the output

— Low - Sets the output to logical low

— High - Sets the output to logical high

— Pulse - If Pulse is chosen in Analog Modulation mode, the modulation 
pulses will appear the output.

— Arbitrary - sets either Marker or Trigger signals at the output. Marker 
signals must be defined for the replayed segment selected in the Segment 
tab. The arbitrary trigger can be configured in the modulation section.
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— Sweep - when the carrier sweep is active, either the valid state of the RF 
output or the sweep trigger can be provided at the multifunction output. 
The sweep trigger can be configured in the RF > Carrier > Sweep tab.

FCP

Used to set up the fast control port (option FCP). Refer to application note:

— Fast-Control-Port-with-MDR-26-Pin-Connector.pdf
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Carrier Section

The vector signal generator can generate unmodulated as well as modulated 
carriers. The carrier must be defined in the Carrier section of the GUI. Next you 
can select from a variety of modulation signals in the Modulation section.

You can vary the Power, Frequency and Phase carrier setting by entering the 
value in the text box, or by using the up and down arrows. You can change 
Step size by entering the appropriate value. The RF ON/OFF button will be 
Green when on, and red when off. 

Crest Factor Section

Allows you to define or retrieve the crest factor (peak-to-average ratio in dB) of 
the modulated signal:

— Manual - specify the value for the maximum crest factor.

— Automatic - depending on the chosen modulation the calculated and 
automatically set crest factor will be provided (for AM, FM, PM and DME, 
ILS, VOR for Option 302)

— AWGN - provides the crest factor of the Gaussian noise if the additive noise 
is enabled.

— Total - provides the combined crest factor of the modulated carrier and 
AWGN, if enabled.

— Refresh - updates the actual crest factor values after modulation has been 
changed.

Refer to the G3-Vector-Signal-Generator-RF-Output-Modes application note.
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Modulation Section

Generator Tab

Allows you to choose between the following internally generated modulations: 

— Pulsed chirp (chirped carrier bursts)

— Multitone

— BPSK (binary phase shift keying)

— Gauss pulse

— Pulse train

Example: Multitone generation

1. Select the CW tab and set the appropriate carrier parameters.

2. In the Generator tab, select Multitone.

3. Open the Generate Equally Spaced Tones window and set number of 
tones and either Spacing or Bandwidth

4. Select Reduce Crest Factor if required.

5. Tone frequencies and relative powers are displayed (scroll down if not all 
tones are visible on the screen). 

6. Change relative power by manually entering the desired value in the 
Power (rel) field.
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7. Add more carriers by selecting the + button and enter Offset, Power (rel), 
and Phase as required. 

8. Remove a particular carrier by selecting the x button next to that carrier.

9. Select RF Off to toggle on the RF Output.

Example: Pulsed chirp

1. Select CW and appropriate carrier parameters in the Carrier section. 

2. In the Modulation > Generator tab, select Pulsed Chirp and specify the 
pulse parameters, as shown below.

3. Select the Generate button. 
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The frequency deviation vs. time is shown below, representing I and Q 
modulation signals vs. time and an IQ phaser plot In the Generation 
Preview area, the number of samples and the estimated upload time is 
also provided.

4. Select Upload to Device to upload the generated modulation.

5. Select the IQ Modulation to turn on IQ Modulation.
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6. Select the RF button to turn RF output on. Notice that the frequency and 
power fields in the Channel tab turn green.

Pulse Train Modulation

A pulse modulation of the previously specified carrier can be defined. None 
means simple amplitude modulation. Other modulation formats are FM Chirp, 
Barker and BPSK (binary phase shift keying). 

— Pulse Type - Two modulation types are available: Trapezoidal and Raised 
Cosine.

— Pulses - In this list pulse sections can be defined.
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— Patterns - In this list pulse sections defined in the Pulse list ma be 
concatenated arbitrarily (including repetitions) to define various pulse 
patterns defining modulation signals.

— PRI - Pulse repetition interval also you to set the period of the pulse train.

— Peak Power - Indicates the maximum instantaneous power of the 
modulation signal.

— Back off - Sets the difference in dB between DAC full scale power and peak 
instantaneous power of the actual modulated signal.

— Upload to Device - Uploads the IQ data to generate the modulation signal.

— Arbitrary Trigger - Refer to the “General Modulation Functions” on 
page 79.

Analog Modulation

In the Analog Modulation tab (Option UNT, Internal analog modulations) you 
may choose between the following internally or externally generated 
modulations:

— FM (frequency modulation)

— PM (phase modulation)

— AM (amplitude modulation)

— Pulse (pulse modulation)

Example FM 

1. Select the CW section and set the appropriate carrier parameters.

2. From the Modulation section, select the Analog Modulation tab > FM.
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3. Set the Modulation Frequency and Frequency Deviation as required.

4. Select the FM off button to turn on modulation of the carrier.

5. Select the RF off button to turn on the RF output.

For Pulse modulation, additional parameters can be defined.

Other Analog Modulation Settings

— Pulse Polarity - A (rectangular) modulating pulse is basically defined by its 
width and duty cycle. The width defines the time interval for 100% 
amplitude and the rest of the period, defined by the duty cycle determines 
the 0% amplitude time interval. This describes Normal pulse polarity, 
whereas for Inverted pulse polarity the roles of 100% and 0% amplitude are 
exchanged.

— Pulse Modulator - When "BB" (baseband) is selected, fast pulse modulation 
with 8 ns resolution is performed. High extinction ratio, the modulation 
bandwidth is 400 MHz, steep pulse slope with pulse jitter around ±1ns.

RF mode yields slower switching but significantly lower pulse jitter in the ps 
range.

— Pulse Output Polarity - the pulse at the MF1 or MF2 output can be inverted 
with the respect to the defined pulse polarity.

— Arbitrary Trigger, Playback Rate, Auto Playback Rate, Update Now, refer to 
the “General Modulation Functions” on page 79.

Digital Modulation

Custom Digital Modulation (Option 431 - Internal digital modulation schemes) 
tab you can choose between the following internally generated modulations:
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— QAM 8

— QAM 16

— QAM 32

— QAM 64

— QAM 128

— QAM 256

— QAM 512

— QAM 1024

— QAM 2048

— QAM 4096

With a maximum symbol rate of 500 MHz

Example: QAM 64 (quadrature amplitude modulation with 64 different 
states)

1. Select the CW section and set the appropriate carrier parameters.

2. From the Modulation section, select the Digital Modulation tab.

3. In the Modulation area, select the Format dropdown and select QAM 64.

4. Specify the QAM 64 parameters:

— Filter Type

— Filter Param

— Pattern Length

— Oversampling 

— Symbol Rate

5. Select the Digital Modulation off button to turn on modulation of the 
carrier.
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6. Select the RF off button to turn on the RF output. Notice that both the RF 
button and Digital Modulation button act as a toggle and turn green when 
turned on.

For Arbitrary Trigger, Playback Rate, Auto Playback Rate, and Update Now, 
refer to the “General Modulation Functions” on page 79.

External Modulation

External modulation is possible with Option FCP via Fast Control Port (FCP). 
Refer to: 
application-notes/G3-Vector-Signal-Generator-Fast-Control-Port.pdf

An external analog I/Q modulation input (Option EXT) accepts externally 
supplied analog I and Q modulation signals from the I IN and Q IN (for each 
channel) connectors. Refer to: 

application-notes/G3-Vector-Signal-Generator-Analog-Inputs.pdf

For Arbitrary Trigger, Playback Rate, Auto Playback Rate, Update Now, refer to 
the “General Modulation Functions” on page 79.

AWGN Modulation

Additive white Gaussian noise, Option 403.

Refer to: 

application-notes/G3-Vector-Signal-Generator-Additive-White-Gaussian-N
oise.pdf
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Arbitrary Waveform Modulation

In the “Segment” tab, waveform files can be uploaded to a specific segment in 
the instrument’s memory. Each waveform file contains IQ samples that can be 
used to modulate the carrier signal. When played back, segments are repeated 
periodically. 

These segments can be concatenated in arbitrary number and order in the 
Sequencer tab, thereby forming sequences of segments that can be replayed.

Accepted file formats: qi,.qid,.wvd, csv,.tdms, iq.tar, and others.

Refer to:

application-notes/G3-Vector-Signal-Generator-Memory-Segmentation.pdf

For Arbitrary Trigger, Playback Rate, Auto Playback Rate, Update Now, refer to 
the “General Modulation Functions” on page 79.

Upload to SD 

The G3 Vector Signal Generator can be optionally configured to have an 
external SD card slot (Option 006). The inserted SD card functions as a 
permanent data storage of the device. This enables you to upload IQ data files 
directly from the SD card to the signal generator. The waveforms on the signal 
generator are then available to be replayed like any other segment on the 
device.

Refer to:

application-notes/G3-Vector-Signal-Generator-Permanent-Data-Storage-S
D.pdf

application-notes/G3-Vector-Signal-Generator-Keysight-IQ-Data-Format-an
d-Device-Upload.pdf

Sweep

— Start Frequency and Stop Frequency is used to define the sweep range

— Sweep Mode is always Linear

— Sweep Direction is Up or Down

— Sweep Blanking - if turned on, suppresses potential artifacts occurring 
between the end of a sweep step and the beginning of the new sweep step.
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— Repetitions - set the number of repetitions and toggle both the Sweep and 
RF buttons to On.

— Dwell/On Time and Dwell/Off Time - define the time the signal generator 
stays at a certain frequency point and is muted suppressed before moving 
to the next frequency point, respectively.

— Sweep Trigger - used to set the source to Immediate, Bus, or External. 
Additional settings for the External source can be specified for MF 1 or MF 2 
and triggered on the positive or negative edge. It also accesses the trigger 
output delay, pulse width, polarity, and output mode. 

General Modulation Functions

Functions that are available for various modulations are listed below. 

Arbitrary Trigger

A pulse train or other modulation may be started as soon as a trigger event 
happens. The internal trigger may act immediately (Immediate) or via Bus 
(SCPI command). An external trigger can be chosen from one of the available 
trigger input connectors (MF1, MF2), i.e. as soon as the trigger slope (Positive 
or Negative, Single or Continuous) of the defined external trigger source 
appears at the respective selected connector.

The trigger may also be executed manually by selecting the Execute Trigger 
button. A trigger delay (Trigger Delay) can also be defined.

Playback Rate
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Each modulation signal has its own sampling rate that is either set 
automatically or given in the QI Metafile. If no information is given, a default  
sampling rate of 500 MHz is assumed. The playback rate is set according to the 
sampling rate and may be changed (changing the modulation signal and 
frequency bandwidth accordingly). 

Auto Playback Rate

Sets the sampling and playback rate automatically when generating a 
modulation.

Update Now

Updates the Playback Rate after a change is made.

Export to File

Custom IQ modulation signal data may be exported to a file in internal memory 
and selected segments of the memory can be played back to modulate the 
output signal.

The trigger signal can be selected to for the MF1 OUT or MF2 OUT connector, 
as described in section “IO (Input Output) Tab” on page 67. The arbitrary 
trigger output signal's, polarity, width, and additional delay may be set with 
the Output Polarity, Output Pulse Width and Output Delay buttons, 
respectively.

For details on signal levels and timing, refer to:

application-notes/G3-Vector-Signal-Generator-Keysight-IQ-Data-Format-an
d-Device-Upload.pdf

Signal Levels and Timing

For details on signal levels and timing, refer to the AP5041A or AP5042A data 
sheet.

data-sheets/G3-Vector-Signal-Generator-Model-AP5041.pdf

data-sheets/G3-Vector-Signal-Generator-Model-AP5042A.pdf

Logging

From the Help menu, select Activate to view and save logging information for 
your session.
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4 Additional Information

“Remote Programming the Signal Generator” on page 82

“Maintenance and Warranty Information” on page 83

“Returning an Instrument for Service” on page 84
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Remote Programming the Signal Generator
The signal generator can be remotely programmed by using SCPI commands. 
Please refer to the Programmer’s Manual for details available on Keysight’s 
website. There are also examples in different programming languages that can 
be used.
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Maintenance and Warranty Information

Adjustments and Calibration

To maintain optimum measurement performance, the instrument should be 
calibrated every 24 months. It is recommended that the instruments be 
returned to Keysight or to an authorized calibration facility. For more 
information please contact our Customer Service Department as indicated on 
www.keysight.com.

Cleaning

Any further maintenance or deep cleaning of the device must be performed by 
Keysight Technologies or its authorized repair specialists.

Repair

The signal generator contains no user-serviceable parts. Repair or calibration 
of the signal generator requires specialized test equipment and must be 
performed by Keysight or its authorized repair specialists.

Warranty Information

All Keysight instruments are warranted against defects in material and 
workmanship for a period of two years from the date of shipment. Keysight will, 
at its option, repair or replace products that prove to be defective during the 
warranty period, provided they are returned to Keysight and provided the 
preventative maintenance procedures are followed. Repairs necessitated by 
misuse of the product are not covered by this warranty. No other warranties are 
expressed or implied, including but not limited to implied warranties of 
merchantability and fitness for a particular purpose. Keysight is not liable for 
consequential damages.

To contact Keysight for sales and technical support, refer to support links on 
the following Keysight websites: http://www.keysight.com/find (product 
specific information and support, software and documentation updates) 
http://www.keysight.com/find/assist (worldwide contact information for repair 
and service).

No operator serviceable parts inside. Refer servicing to qualified 
personnel. To prevent electrical shock do not remove covers.

To prevent electrical shock, disconnect the instrument from mains before 
cleaning. Use a dry cloth or one slightly dampened with water to clean the 
external case parts. Do not attempt to clean internally.
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Returning an Instrument for Service

Calling Keysight Technologies 

Keysight Technologies has offices around the world to provide you with 
complete support for your instrument. To obtain servicing information or to 
order replacement parts, contact the nearest Keysight Technologies office 
listed below. In any correspondence or telephone conversations, refer to your 
instrument by its product number, full serial number, and software revision. 

Locations for Keysight Technologies

Online assistance: http://www.keysight.com/find/assist

Americas

Canada
1 877 894 4414

Latin America
(305) 269 7500

United States
1 800 829 4444

Asia Pacific

Australia
1 800 629 485

China
800 810 0189

Hong Kong
800 938 693

India
1 800 112 929

Japan
0 120 (421) 345

Korea
080 769 0800

Malaysia
1 800 888 848

Singapore
1 800 375 8100

Taiwan
0800 047 866

Thailand
1 800226 008

Europe & Middle East

Austria
43 (0) 1 360 277 1571

Belgium
32 (0) 2 404 93 40

Denmark
45 70 13 15 15

Finland
358 (0) 10 855 2100

France
0825 010 700*
*0.125 Euros/minute

Germany
49 (0) 7031 464 6333

Ireland
1890 924 204

Israel
972-3-9288-504/544

Italy
39 02 92 60 8484

Netherlands
31 (0) 20 547 2111

Spain
34 (91) 631 3300

Sweden
0200-88 22 55

Switzerland
0800 80 53 53

United Kingdom
44 (0) 118 9276201

Other European Countries: http://www.keysight.com/find/contactus
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Service Options 

Keysight Technologies offers several optional maintenance plans to service 
your instrument after the warranty has expired. Call your Keysight 
Technologies office for full details. 

If you want to service the instrument yourself after the warranty expires, you 
can download the service documentation that provides all necessary 
troubleshooting and maintenance information from the Keysight web page. 

Packaging the Instrument

Use original packaging or comparable. It is best to pack the unit in the original 
factory packaging materials if they are available.

You can repackage the instrument with commercially available materials, as 
follows:

Instrument damage can result from using packaging materials other 
than those specified. Never use styrene pellets in any shape as 
packaging materials. They do not adequately cushion the equipment 
or prevent it from shifting in the carton. They cause equipment 
damage by generating static electricity and by lodging in the 
instrument louvers, blocking airflow. 

M9484C Rear Panel and Front Panel jumper cables (PN: W1312-20511 and 
W1312-20516) come with protective caps to protect them from impact 
damage during shipping. When returning an instrument for service, reinsert 
the protective caps (if available) or remove the cables and place them in a 
separate protective bag.

Table 4-1 

Step Notes

1. Wrap the instrument in 
anti-static plastic to reduce the 
possibility of damage caused by 
electrostatic discharge

2. Use a strong shipping container. The carton must be both large enough and strong 
enough to accommodate the instrument. A 
double-walled, corrugated cardboard carton with 159 
kg (350 lb) bursting strength is adequate. Allow at 
least 3 to 4 inches on all sides of the instrument for 
packing material. 
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3. Surround the equipment with 
three to four inches of packing 
material and prevent the 
equipment from moving in the 
carton.

If packing foam is not available, the best alternative is 
plastic bubble-pack. This material looks like a plastic 
sheet filled with 1-1/4 inch air bubbles. Use the 
pink-colored bubble which reduces static electricity. 
Wrapping the equipment several times in this material 
should both protect the equipment and prevent it from 
moving in the carton. 

4. Seal the shipping container 
securely with strong nylon 
adhesive tape.

5. Mark the shipping container 
“FRAGILE, HANDLE WITH 
CARE” to assure careful 
handling. 

6. Retain copies of all shipping 
papers. 

Table 4-1 

Step Notes
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